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Introduction

Welcome to the WinDisKlone on-line documentation and help file.      
WinDisKlone is a Windows 3.x application and uses standard Windows 
techniques.    This document covers areas that are specific to 
WinDisKlone.    If you need information about using Windows, please 
refer to your Microsoft Windows documentation.

Overview

WinDisKlone makes the chore of copying, comparing, and 
formatting diskettes a snap.        WinDisKlone loads an image of 
the selected diskette into memory by reading a track at a time,
compressing the track, and storing it into memory.    The 
diskette will be loaded up to and including the last track with 
data on it to provide the fastest possible load time.    The 
diskette image can produce multiple copies of the original 
diskette or be saved to a disk file for future use.    The help 
menu lists several general help areas, including the help index 
and help commands.

Procedures

The initial execution of WinDisKlone provides two primary options --    
the Load option and the Format option.    The Copy and Compare 
options will be disabled until a diskette image has    been successfully 
loaded into memory.    The File menu allows exit from the program.    
And, of course, the Help option is enabled at all times.    

The Load option allows the loading of a diskette image by reading a 
diskette or by loading file from disk. 

The Copy option allows copying a diskette image to a diskette image or
to a disk file.    The diskette image may be copied to a diskette of the 
same or higher density.

The Compare option allows the diskette image in memory to be 
compared    to a diskette of the same or higher density.    If the diskette 
is the same density as the diskette image, then the diskette is 
compared track by track until the end of data in the diskette image is 



reached.    If the diskette is a higher density, then only the data area is 
compared until the end of data in the diskette image is reached.

The Format option allows a Quick Format without copying the operating
system (OS), a Quick Format with OS, a Full Format without OS, a Full 
Format with OS and just a transfer of the OS.    WinDisKlone makes use 
of the Input/Output Control (IOCTL) subfunctions to format diskettes.    
This allows direct communication with the device drivers to provide the
highest degree of compatibility possible.    The Quick Format simply 
initializes the boot sector, File Allocation Table, and Root Directory.    
The Quick Format option requires a diskette to have been previously 
formatted.

WinDisKlone supports loading, copying, comparing, and 
formatting 360K, 720K, 1.2M, 1.44M, and 2.88M diskettes.    

Compatibility

WinDisKlone is compatible with Microsoft Windows versions 
3.0 and 3.1.



WinDisKlone Index
To display a topic, click on the underlined title.

Commands
Help
Menus
Procedures



WinDisKlone Commands
To get help with a particular command, choose the appropriate menu.

File Menu Command
Exit

Load Menu Commands
Diskette to Memory...
File to Memory...

Copy Menu Commands
Memory to Diskette...
Memory to File...

Compare Menu Commands
Memory to Diskette...

Format Menu Commands
Diskette...

 
F1 = Help Menu Commands
Index
Commands
Print Invoice
About WinDisKlone...



File Menu Help
The File menu allows you to exit the program.

Exit                  Exits WinDisKlone  



Load Disk Help
The Load menu allows you to load a diskette image into memory from either 
a diskette or a previously saved file.

Diskette to Memory...

Loads a diskette image from diskette into memory.    Select the Load All
Tracks option if you desire to read all tracks.    The default is only tracks
up to and including the last track containing data is loaded.

File to Memory... 

Loads a diskette image previously saved as a file into 
memory.



Load File Help
The File to Memory option allows you to load a diskette image into memory 
from a previously saved file.

File to Memory... 

Loads a diskette image previously saved as a file into memory.    The 
Select File dialog box enables you to select the filename of the diskette
image previously.    The dialog box lists the files with the default 
extension WDF.    Once a file is selected (highlighted), the dialog box 
will display disk size and capacity of the diskette whose image will be 
loaded in memory.    In addition, information about the WDF file will be 
displayed.    This includes size of the WDF file and date and time the 
WDF file was created.    To load a file, simply enter a filename on the 
FileName line or select a filename in the Files box and depress the 
ENTER key. 



Copy Disk Help
The Copy menu allows you to copy the diskette image contained in memory 
to a diskette or to a file.

Diskette to Memory...

Copys a diskette image from memory to a diskette.    The target 
diskette may be    may be different than that of the source diskette 
according to the following table:

Source                  Target  

360K 360K, 720K, 1.2M, 1.44M, 2.88M
720K 720K, 1.2M, 1.44M, 2.88M
1.2M 1.2M, 1.44M, 2,88M
1.44M 1.44M, 2.88M
2.88M 2.88M

The target diskette, if not already formatted, will be formatted if Force 
Format is selected.    When the Force Format box is checked, a dialog 
box will appear that will afford the opportunity to format the target 
diskette to the desired density.    If the target diskette is not formatted, 
WinDisKlone will attempt to format the target diskette based on the 
capacity of the target drive.

File to Memory... 

Copys a diskette image from memory to a file.



Copy File Help
Memory to File option allows you to load a diskette image into memory from 
a previously saved file.

Memory to File...

Saves a diskette image to a disk file.    The Select File dialog box 
enables you to enter a description up to 30 characters of the diskette 
you wish to save to a file.    This will enable to you to quickly locate the 
diskette image when it comes to time to load it from disk into memory. 
The file may be saved to any disk, including diskettes.

Saving a diskette image is very easy.    Simply enter a filename on the 
FileName line and depress the ENTER key.    If the filename you have 
selected already exists, you will have the opportunity to change it if 
you wish.



Compare Disk Help
The Compare menu allows comparing the diskette image in memory to a 
diskette.

Memory to Diskette...

Compares a diskette image in memory to a diskette.



Format Disk Help
The Format menu allows the formatting of a brand new diskette or the 
reinitialization of a previously formatted diskette.    The Operating System 
can also be transferred to the diskette.

Diskette...

Formats a diskette, with or without transferring the Operating System. 
There are five Format Options:

Quick Format without System 
Quick Format with System 
Full Format without System 
Full Format with System 
Tranfer System Only

The Quick Format option simply initializes the boot sector, the File 
Allocation Tables and the Root Directory.    The Quick Format will work 
only if the target diskette has been previously successfully formatted.

The Full Format option in addition to creating the boot sector, File 
Allocation Tables, and Root Directory,defines the sectors, to which 
data will be stored.    The Full Format option will take significantly 
longer than the Quick Option because it has to write to and verify that 
write on every sector on the diskette.    

The Transfer System option will copy the Operation System to the 
target diskette to make it a bootable diskette.



F1=Help Menu Help
Help for WinDisKlone may be accessed two ways:

- Pressing F1 (when no menu is highlighted).    To exit the F1 = 
Help pulldown menu without taking any action, click or drag 
the mouse anywhere outside the menu, or press the Esc 
(escape) key.

- Using the Help pulldown menu:

The    Help pulldown menu brings up various types of help which make up the
on-line documentation for WinDisKlone.

Index

Displays the help index.

Commands
 

Displays the complete list of menu commands.

Print HELPID_HELP_MENU Invoice

 Prints an invoice for registering    WinDisKlone.    If you are 
evaluating the shareware version of the program, and you intend
to make continued use of it, you are obligated to register the 
program.    Improvements to WinDisKlone can only be made if 
you support the shareware concept.    Shareware is not freeware 
or public domain software.    There are privileges and incentives 
to becoming a registered user.    Please read the README.DOC 
file for details.

About HELPID_HELP_MENU WinDisKlone...

Displays a dialog box containing the current program version, 
copyright notice and obligatory head-swelling credits for the 
author.



What is Shareware?
Shareware is copyrighted commercial software that you are allowed to try 
out before you make the purchase decision.    It is a marketing concept, not 
a type of software.

Shareware marketing is typically used when the author doesn't have a huge 
advertising budget.    High end software like Lotus 1-2-3, dBase IV, etc. may 
have advertising budgets of over a million dollars.    A full page 
advertisement in a magazine like PC Magazine can cost over $10,000 an 
issue.    Smaller software companies, like MaeDae Enterprises, usually don't 
have that type of advertising budget so shareware marketing is used.

Many people question whether software distributed via shareware is of as 
high a quality as the software they see advertised in commercial 
magazines.    Good commercial advertising can sell almost any software 
regardless of its quality.    Shareware must be of equal or higher quality than
commercially available software for users to register.    You, the user, have 
the opportunity to evaluate the shareware and find the real gems.    With 
commercial software, you purchase the software and then hope it works as 
advertised.    

Note:    Don't feel guilty about passing around copies of shareware.    You are helping the author 
distribute his software.    Even though shareware is commercial software, you are encouraged to pass
around evaluation copies!



More Information
For more information about WinDisKlone, EZ-DisKlone Plus and EZX Publishings other
products, open EZXINFO.WRI    (while running the Windows's WRITE program), or open
up an MS DOS window and run EZXINFO.EXE, a self running and printable text file.

WinDisKlone for Windows 3.x    Version 4.1 released! 

Copy, compare, and format diskettes! Supports Compressed Diskette Image Files.
Working with floppy diskettes under Windows just became easy.    WinDisKlone will copy
and compare diskettes in a single pass using any available memory in your system (real
or virtual).    WinDisKlone is a Windows based diskette duplicator that features single pass
operation, format conversion, background operation, and much, much, more. 

WinDisKlone goes beyond any comparable diskette duplicator on the market:

· Load any size diskette into memory in a single pass using any available    memory in your system.    
· Smart loading speeds up operations significantly by allowing you to ignore    empty diskette tracks. 
· Once a diskette has been loaded, you can make as many copies or compares as    you want without reloading the 

source diskette for each operation.
· Format diskettes using one of several options like quick format or full    format with system.                
· Work with diskettes in the background allowing several things to take place    at once.
· Automatically convert diskettes from a lower capacity to a higher capacity    during the copy and compare 

operations.    For example, load a 360K diskette    and copy it to a 1.44M diskette.    Try that with DOS!
· Diskettes can be written to compressed diskette image files on your hard disk.    Descriptions may be
    added to the diskette image file allowing easy cataloging.    Reloading a diskette from file only takes a
    couple of seconds.
· Built-in help makes even the most complex operation seem easy.
· High performance much faster than the File Manager for diskette duplication.
· Multi-tasks under Windows with full background operation to free up your    computer fast! 
· WinDisKlone is compatible with Windows (3.x) and DOS (3.0+).
· For a sophisticated, flexible, easy to use, total solution to diskette      reproduction needs, nothing surpasses 

WinDisKlone for Windows.

A single machine license is $79 plus Shipping & Insurance.
A 10 machine license is $395 (stand alone or LAN).

LAN server license is $695 per 100 concurrent users; $7 per user thereafter.
An unlimited site license is only $2995.

An unlimited corporate wide license is only $30K.

The DOS version is call EZ-DisKlone Plus is ony $79 plus S&I. $395/10 machine.
$695/LAN server/100 users. $2995 unlimited site. $30K Corporate.

Please note: Due to operating system limitations, there is no image file correspondence
between DOS and Windows versions of "DisKlone".

You may also order BOTH WinDisKlone & EZ-DisKlone Plus for $129 plus S&H.
$495/10 user. $795/LAN server/100 users. $3995 unlimited site. $40K corporate.

Credit card orders may call TOLL FREE 1-800-800-2468
Visa/MasterCard/Discover/Amex accepted.



For information and Internantional call:
713-280-9900 (Voice); 713-280-0099 (FAX);    713-280-8180 (BBS)

Mail orders to: EZX Publishing, Box 58177, Webster, TX 77598-8177 USA

S&I is $7 USA/48; $12 elsewhere in North America; $24 International.



Registration Benefits
Registration benefits include:

· The latest version of WinDisKlone without these information screens.
· A full installation program, which completely automates setup of WDK.
· Registered user support via phone, BBS, mail, or FAX.
· Notification of low cost upgrades.
· Notification of enhancements.
· For more information about WinDisKlone, EZ-DisKlone Plus and EZX    
Publishing's other products, open EZXINFO.WRI    (while running the    
Windows's WRITE program), or open up an MS DOS window and run      
EZXINFO.EXE, a self running and printable text file.

A single machine license is $79 plus Shipping & Insurance.
A 10 machine license is $395 (stand alone or LAN).

LAN server license is $695 per 100 concurrent users; $7 per user thereafter.
An unlimited site license is only $2995.

An unlimited corporate wide license is only $30K.

The DOS version is call EZ-DisKlone Plus is ony $79 plus S&I. $395/10 
machine.

$695/LAN server/100 users. $2995 unlimited site. $30K Corporate.

Please note: Due to operating system limitations, there is no image file 
correspondence

between DOS and Windows versions of "DisKlone".

You may also order BOTH WinDisKlone & EZ-DisKlone Plus for $129 plus S&H.
$495/10 user. $795/LAN server/100 users. $3995 unlimited site. $40K 
corporate.

Credit card orders may call TOLL FREE 1-800-800-2468
Visa/MasterCard/Discover/Amex accepted.

For information and Internantional call:
713-280-9900 (Voice); 713-280-0099 (FAX);    713-280-8180 (BBS)

Mail orders to: EZX Publishing, Box 58177, Webster, TX 77598-8177 USA

S&I is $7 USA/48; $12 elsewhere in North America; $24 International.


